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Module One: Getting Started  

Welcome to the Advanced Post Course manual. You can use advanced forms and tasks 

to do even more in Access than you have previously learned. For example, you can use 

Access to create mailing labels, work with SQL and publish a Web database—among other 

things. By the time you finish this course, you will be able to navigate Access and create 

reports like a pro. Sit back, relax and have fun. You are in for a thrilling ride!  
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Objectives  
Research has consistently demonstrated that when clear goals are associated with 

learning, it occurs more easily and rapidly.   

With this manual, students should have learned how to:  

• Use the Quick Start group, Property Sheet, table macros, report sections, 

conditional formatting, Expression Builder and logical functions.  

• Add, move, remove and format both regular and calculated controls  

• Set the Primary Key  

• Create a subform, Web form, split form, modal dialog, PivotChart, PivotTable 

and mailing labels  

• Group and sort data  

• Understand, view and edit relationships  

• Understand and establish referential integrity  

• Sort and filter a query  

• Add calculated fields  

• Understand what SQL is, what SQL statements are, basic SQL syntax and the 

uses for SQL within Access  

• Link to, import and export an Excel spreadsheet, Access database, SharePoint 

list, text or XML file and other types of links, imports and exports  

• Use the Database Documenter, analyze table and database performance and 

repair and compact a database  
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Module Two: Advanced Table Tasks  

In this module you will acquaint students with six different advanced table tasks: using 

the quick start group, using the property sheet, adding, moving, and removing controls, 

formatting controls, setting the primary key and using table macros.    
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Using the Quick Start Group  
Quick Start groups are an easy way to input information without entering it over and over 

again. There are various groups that you can create, including address, category, name, 

payment type, phone, priority, start and end dates, status and tag.   

Some Quick Start groups will have predefined list items, which you can also add on to.  

For example, let’s say you want to add payment types to your table. The predefined 

payment type list items are cash, credit card, check, debit and in kind. You can use these 

predefined list items, remove the ones you don’t need and even add your own. For this 

example, we will delete the in kind and check list items and add Paypal as a payment type 

selection.  

1. Open your table  

2. Highlight the field that is to the right of where you want your new Quick Start 

group to appear. In this example, we are going to put our payment type 

Quick Start group to the left of the ID column.   

 

  

3. Click the “More Fields” option from your menu.  

4. Scroll down to the Quick Start section and choose “Payment Type.”  
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5. Once your Payment Type Quick Start Group is on your table, right click anywhere 

on the column.  

A menu will pop up. From that menu, select “Edit List Items” at the bottom.  
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6. A menu box will pop up that contains the predefined list items. If you want to 

delete a list item, highlight it and hit your backspace key. If you want to add a list 

item, just type it in. For this example, we are going to delete Check and in kind, 

and add Debit and Paypal.  

  
7. Press the “OK” button and your new Payment Type Quick Start group will contain 

the new list items.  
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Using the Property Sheet  
The property sheet gives you an easy way to edit the design of your report. By 

displaying the property sheet and then clicking on a selection within your report, you 

can change or add features within your report.   

To access the Property Sheet, click on the “Create” tab within Access and selecting the 

“Report” icon from the menu. The “Design” menu should open up immediately and the 

Property Sheet icon is all the way at the end.  

  

 

Clicking this icon will bring up the Property Sheet.   
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Click on one of the fields to change its value or to add a value if one does not exist. For 

example, the Last Name column is to wide in the table above, so we are going to shorten 

it.   

1. Start by clicking on the column header, which is last name.   

2. Go over to the property sheet and find the “Width” selection.   

3. In the box next to that selection, delete “2.3854,” replace it with “1.”  

4. Hit the enter key.   

Our new report looks like this:  
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Adding, Moving and Removing Controls  
Report controls are located under the design tab, in a rectangular box with the label 

“controls” under it.   

 

  

To add controls:  

1. Click on the control you want to use from the design menu.  

2. Click on the spot on our report where you want the control to go.  
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To move controls after they are on your report:  

1. Scroll over the control until your pointer looks like two double-sided arrows 

intersecting each other.  

2. Click on the control.  

3. Slide it to a new spot on your report.  

  

To delete a control that was placed on your report:  

1. Scroll over the control until your pointer looks like two double-sided 

arrows intersecting each other.  

2. Right click on your mouse.  

3. Select “delete” from the list menu.  

  

Formatting Controls  
You can format controls to make them look how you want them to.   

 

 

To format a control:  

1. Select the “format” tab.  

2. Scroll over the control until your pointer looks like two double-sided 

arrows intersecting each other.  
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3. Click on it.  

4. Choose an option from the formatting tab. You can change the font size, 

type, color and many other features of your control.  

 

Setting the Primary Key  
The Primary Key is a unique identifier that distinguishes one entry in your table for 

another. For example, account numbers are a good Primary Key because they are unique 

to each customer and will set one customer apart from the other customers—now and in 

the future. You will never take one customer’s account number and assign it to another 

customer. An example if a bad Primary Key is a first or last name. You may not have two 

customers with the same first or last name now, but you might in the future.  

To set the Primary Key:  

1. Click the “View” icon from the Home tab, which is the first one from the left.  

2. Select “Deign View” from the dropdown menu.  

3. Under “Field Name” select the field that you want to set as the Primary Key.  

4. Click the “Primary Key” icon from the design menu. It will light up.  

 

5. You will see a key icon next to the field that you have set as the Primary Key.  

 

You have now set a Primary Key for the table.   
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Using Table Macros  
There are two types of table macros, event driven macros and named macros. Event driven 

macros are activated by a certain event happening within the table. Named macros are 

activated when summoned by their name.   

To create an event driven macro:  

1. Click on the “Table” tab.  

  

2. Choose an event from one of the event options, which are “Before Change,” 

Before Delete,” “After Insert,” “After Update” and “After Delete.”  

 

3. The macro menu will open up with a dropdown box for you to choose the action 

you want it to perform. Make a selection from the dropdown menu and then 

enter a description for the action.  
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4. Click the “Save” button from the Table menu.  

 

5. Click the “Close” button from the Table menu.  
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You have created a new event driven macro. You will know what events already have a 

macro linked to them because the event will be lit up in the Table menu.  
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Module Three: Advanced Form Tasks  

In this module, students will learn how to create three different advanced forms: a 

subform, Web form and split form. They will also learn how to create three advanced tasks: 

a Modal Dialog, PivotTable and PivotChart.    
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Creating a Sub Form  
  

1. Click the “Create” tab.  

2. Click on the form icon. A new form will open.  

  

  

  

3. Click on the sub form icon, which is highlighted in yellow.   

4. Click on the area of the form, where you want place the sub form.  
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Creating a Web Form  
Open access and click on the pink file tab.  

Scroll down to “New” and then choose “Blank web database.” Click on “Create.”  

  

Once your new database is open, click the “Create” tab and then select the “Form” icon.  
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Your new page with your web form should look like this:  

   

Creating a Split Form  
Click on the “Create” tab and select the “More forms” option. Scroll down to the “Split 

form” option.  
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Your new split form should look like this:  

 

Creating a Modal Dialog  

Click on the “Create” tab and select the “More forms” option. Scroll down to the “Modal 

Dialog” option.  

  
 

Your new Modal Dialog should look like this:  
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Module Four: Advanced Reporting Tasks  

In this module, students will learn how to perform certain advanced reporting tasks, 

including using the report sections, using conditional formatting, grouping and sorting 

data, adding calculated controls and creating labels.  
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Using Report Sections  
Report sections consist of Report Header, Page Header, 

Group Header, Detail, Group Footer, Page Footer and 

Report Footer. These sections make up the design of the 

report, so it is essential that you know how to use them.  

To see these sections, you need to open your report in 

“Design View,” which is done by selecting the “View” icon 

under the Home tab and then selecting “Design View” 

from the menu that opens up.  

  

This is what you will see. Notice the report sections we 

talked about (the groups header and footer are not 

shown):  

  
Use the report header when you want to insert items on in the header of your report 

cover page. Items that you might want to include on a cover page header include the title 

of the report or a related image.  
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Use the page header for items that you want to insert into the header of every single 

page of your report. For example, you may want to have the title of the report on each 

page.   

Use the group header to signal the beginning of a new group. The group header will be 

placed at the beginning on each group. A good example of something to put as the group 

header is the name of the group.  

Use the details section for the controls that make up the body of your report.   

Use the group footer to signal the end of a group. The group footer will be placed at the 

end of each group. You may want to use this space to summarize the details of the group.  

Use the page footer for items that you want to show at the bottom of each page. A 

common use of page footers is to display page numbers or the section/group name that 

the page is found under.  

Use the report footer to summarize the details of the entire report or to report a total if 

your report pertains to expenses, profit/loss, etc.   

Here is a sample of a report in Design View:  
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And the same report in Report View:  
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Using Conditional Formatting  
  

Conditional formatting allows you to insert automatic formatting when certain conditions 

are met. These conditions are specified by you. Access will allow you to create up to 50 

conditional formatting rules per control or control set.   

Create conditional formatting rules:  

1. First you will need to open the report in the “Layout View” located by clicking the 

“View” icon on the Home menu.  

  

2. Select the Format tab and choose “Conditional Formatting” icon from the Format 

menu.  

  
3. The Conditional Formatting Rules Manager box will open up.  
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4. Click on “New Rule” to define a new rule.  

  

5. The New Formatting Rule box will open up.  

  

6. The first thing you need to do in this box is to choose whether you want to 

“Check value in the current record or use an expression” or “Compare other 

records.”  

  

7. Underneath the rule type section, you will find the section to edit the rule 

description.  
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8. In the first box, choose whether you want the formatting to occur where there is a 

field value or an expression.  

  

9. For the next box you will need to choose where the field value or expression must 

or must not be, in order for the formatting to occur. You have several options, 

including “between,” “not between,” “equal to,” “not equal to,” “greater than,” 

“less than,” “greater than or equal to” and “less than or equal to.”  

  

10. Set your new rule by placing a value in both of the boxes below.  

  

11. Click “OK” on the New Rule Formatting box.  
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12. To create another rule click “New Rule” again or click “OK” on the Conditional 

Formatting Rules Manager box if you are finished creating rules for the control or 

group of controls.  

You can change the priority of or delete your conditional formatting rules by:  

Go back to your Conditional Formatting Rules Manager box.  

  

Highlight the rule you want to delete by clicking on it and then clicking the “Delete Rule” 

button.  

  

Highlight the rule you want to move by clicking on it and click the up or down arrow next 

to the “Delete Rule” button.  

  

Grouping & Sorting Data  
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1. Put your report into “Layout View.”  

2. Right click on the column that you want to group or sort.  

3. Choose “Group on (column name,)” “Sort A to Z” or “Sort Z to A.”  

In this example, sort a report by last name.  

First, put the report in “Layout View.”  

 

  

 Then right-click on my “Last Name” column and a menu pops up.  

Select “Sort A to Z” to put my last names into alphabetical order.  
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 The new report looks like this:  
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Adding Calculated Controls  
  

1. Choose a control to from the “Controls” box on the Design menu tab.  

2. Click on the spot on your report where you want the control to go. The report 

below had a text box control added called “Cost.”  

  

1. Click on the “Property Sheet” icon from the “Tools” box on the Design menu tab.  

  

2. Under “Name” will be an options called “Control Source,” which will have an 

empty box with a drop down menu next to it. This down box will also have a 

button with an ellipsis on it. Click on the ellipsis button.  
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3. The Expression Builder box will pop up. You can input your calculated control 

expressions into this box. The report below had “=[Cost]*.85” to discount the cost 

by 15% during an special discount period.  

  

4. Click “OK.” An Enter Parameter Value box may pop up to have you set a value for 

part of your new expression.   
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Creating Labels  

Click on the “Label” icon, which is under the Create tab in the “Reports” box.  

  

The Label Wizard box will pop up.   

  

Choose the label size that you need, if you size is listed. If not, you can create a customized 

label to fit your specifications by clicking on the “Customize” button.  

  

You can filter the label list be manufacturer to make it easier to find your label. You will 

also need to choose between an English or metric unit of measure and a sheet feed or 

continuous label type. Click the “Next” button.  



Best STL 2014 ©  www.microsofttraining.net  Page 34  

  0845 5194 797  

  

You can select your font type, size, weight and color on the next page. You can also place 

a check mark in the italic and/or underline boxes, if you want either of those options. Click 

the “Next” button.  

  

On the next page you will choose which fields from your report that you want included 

on your labels.  

To select a field, click on it and then click on the > button. The field should show up in 

the Prototype  

Label box. Click “Next.”  
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On the next page, you can decide how you want your labels sorted. Send selections from 

the Available Fields box to the Sort By box by clicking the > and >> buttons. Once 

finished, click “Next.”  

  
On the last page, name your report and choose “See the labels as they will look printed” 

or “Modify the label design.” Click “Finished.”  
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Your labels will open up in Print Preview automatically.   
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Module Five: Understanding Relationships  

This module will teach students about the different types of relationships, how to view 

relationships, how to edit relationship, what referential integrity is and how to establish it.   
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Types of Relationships  
Relationships area means to join data to different tables, while avoiding redundancy in 

the tables. Therefore, you can divide your data into different tables—using it only once—

and then add it into other tables by establishing relationships.   

There are three types of relationships:  

• A One-to-one relationship is where each entry on table 1 can only have a 

relationship with one entry on table 2 and each entry on table 2 can only have a 

relationship with one entry on table  

1. These types of relationships are rare.  

• A One-to-Many relationship is where each entry on table 1 can have a 

relationship with multiple entries on table 2, but not vice versa.   

• A Many-to-Many relationship is where each entry on table 1 can have a 

relationship with multiple entries on table 2 and each entry on table 2 can have a 

relationship with multiple entries on table 1.   

One big reason for creating table relationships: creating relationships provides a 

foundation for establishing referential integrity, which will be discussed in a later section.  
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Viewing Relationships  
  

To view your relationships:  

1. Click on the Relationships icon, which is located under the Database Tools tab.   

 

2. If you have Relationships that are already defined, then a relationship tab will 

open up and display your relationships.  

  
3. You will have the option to show all of your relationships or just the direct 

relationships. You can also hide the table or close the relationship tab completely.  
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 Editing Relationships  

To edit your relationships:  

1. Open your relationship tab.  

2. Select the relationship that you want to edit.  

3. Click “Edit Relationships” in the Tools box.  

  

4. An edit box will open.  

  

5. Make your changes in the Edit Relationships box and then click “OK.”  
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About Referential Integrity  
The goal of referential integrity is to avoid having “orphaned” data. “Orphaned” data can 

happen when you are deleting or updating the data in your tables.   

For example, if you have a customer on table 1 that is linked to payments on table 2 and 

then you delete that customer, then the payments linked to that customer on table 2 will 

become “orphaned” data.   

Referential integrity prevents this by denying changes that will result in “orphaned” data.  

Since you may have a valid need to delete or update data in your tables, you can choose 

to allow Access to update or delete data that have a relationship with the data you are 

updating or deleting.  
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Establishing Referential Integrity  
  

1. In the Edit Relationships box, place a check mark in the box that says “Enforce 

Referential Integrity.”  

  

2. The choices to “Cascade update related fields” or “Cascade delete related 

records” will open up. Put a check mark in one or both of these boxes if you want 

to allow Access to update or delete data that have a relationship with the data 

you are updating or deleting. 3. Then select “OK.”  
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Module Six: Advanced Query Tasks   

  

In this module, students will learn about advanced query tasks, such as sorting and 

filtering a query, adding calculated fields, using the Expression Builder and using logical 

functions.  
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Sorting and Filtering a Query  
  

1. Go to the Home tab and select the “Filter” icon from the Sort & Filter box.  

  

  

2. If you want to sort the query, select “Ascending” or “Descending” instead of 

“Filter.” Choose “Ascending” to put your field in alphabetical order.  

  

3. Choose “Descending” to put it in reverse alphabetical order.   



   

Best STL 2014 ©  www.microsofttraining.net  Page 45  

  0845 5194 797  

  
 

4. Choose “Remove Sort” if you want to undo the sorting that you have already 

performed on your query.  
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Adding Calculated Fields  
  

1. Click on the “More Fields” button, which is under the Fields tab in the Add & 

Delete box.  

  

2. Click on the type of calculated field you want to create. Your options are text, 

number, currency, yes/no and time/date.  

3. This will open the Expression Builder. You will use it to create calculated fields.  
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Using the Expression Builder  
  

1. The Expression Builder helps you create a calculated field.   

  

2. You will put your expression into the big white box.   

3. Click “More >>” if you want to choose your expression elements, expression 

categories and expression values.   

  

4. Click “<< Less” if you want to revert back to the simplier version of the Expression 

Builder.  

Using Logical Functions  

Logical functions are built-in functions that help make building an expression easier. 

Expression categories include conversion, date/time, financial, inspections, math, program 

flow and text. Each expression category has a list of expression values that you can use in 

your expression.  
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1. To use a logical functions, click on “More >>” on the right hand side of the 

Expression Builder.   

  

2. Click the + sign next to “Functions” in the Expression Elements box.  

  

  

  

3. Select “Built-in-Functions,” choose a selection from the Expression Categories box 

and then the needed function from the Expression Values box.  
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Module Seven: Working with SQL   

In this module, students will learn about the relationship between Access 2010 and SQL. 

They will discover what SQL is, what an SQL statement is, they will learn about basic SQL 

syntax and they will learn about the various uses of SQL in Access 2010.   
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What is SQL?  
SQL is an acronym for Sequence Query Language. Access is the database; SQL is the 

language that is used to retrieve information from an Access database. In other words, 

you use SQL to retrieve data from an Access database.   

An Access database can—and often does—hold a lot of information. It can be time 

consuming to search a large database for the exact information that you need. In a 

situation like this, using SQL to search for and find the information that you need can save 

you time and effort.   

SQL can also work as a retrieval system for in-users. For example, if you have a personnel 

database, employees within the personnel office can use SQL statements to retrieve data, 

but most cannot modify the data within the database.    

You can keep all or most users are in a read-only mode, which will disallow them 

permission to modify the data. Different permissions can be set for different users.   
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Understanding SQL Statements  

An SQL statement is created from a series of clauses that detail the data you want to 

search for. For example, the statement below is made up of three clauses: select, from and 

where. It says that we want to search the “Payment Type” field from Table 1 for customers 

who paid with Paypal.  

  

In order to see or edit SQL statements, you must be in “SQL View,” which you get to by 

going to the View option under the Home tab and then choosing “SQL View.”  

  
There are six common clauses for SQL statements, although they are not the only ones. 

These six common clauses are:   

• select  

• from   

• where  

• order by  

• group by   

• having  
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Most clauses are optional, but two of them are required for every single SQL statement. 

These two required clauses are select and from, because you must have a database and 

field from which to search for the data.  

Basic SQL Syntax  
SQL statements are created by a group of SQL clauses and SQL clauses are created by 

SQL syntax. Basic SQL syntax includes the following terms:   

• identifier  

• operator  

• constant   

• expression   

An SQL clause can be compared to a sentence and each term can be compared to a part 

of a sentence.   

An identifier is comparable to a noun in a sentence. It describes the database object that 

you want to search for. “Customers.[Payment Type]” is an example of an identifier.    

An operator is comparable to a verb or adverb in a sentence. It describes an action that 

you want to perform or modifies an action. “as,” “and” and “or” are all operators.    

A constant is comparable to a noun in a sentence. It describes an unchanging value. 

“100” and “NULL” are examples of a constant.    

An expression is comparable to an adjective in a sentence. It combines all of the above 

plus functions to create a single value. “>= Customer.[Payment Type]” is an example of 

an expression.    

Uses for SQL in Access  

As we have already learned, the main use of SQL in Access is to retrieve data from a 

database, based on statements given by the user.   
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We have also briefly touched on a second use for SQL in Access, which is to give in-users 

the ability to search for and retrieve data from a database, without allowing them access 

to the entire database.   

We looked at an example of personnel employees being able to quickly find employee 

information in a database, without the need to access the entire database.   

A third use of SQL in Access is to use it as a way to update a database remotely, so that 

no one else is actually going into the database and modifying the raw data.  

This last uses has two important benefits” it leaves less room for error and lessens the 

possibility of modifying the wrong data, which can be detrimental to the entire database.   
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Module Eight: Linking Data  

In this module, students will learn how to link data. Topics will include linking to an Excel 

spreadsheet, linking to an Access database, linking to a SharePoint list and linking to a 

text or XML file. We will also look at other types of links.   
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Linking to an Excel Spreadsheet  
  

To link to an Excel spreadsheet:  

1. Go to the “External Data” tab and choose the Excel icon from the Import & Link 

box.  

  

  

2. The “Get External Data – Excel Spreadsheet” box will pop-up.   
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3. Browse for the source of the data.   

4. Choose “Link to the data source by creating a linking table.”  

5. Hit “OK.”   
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Linking to an Access Database  
  

To link to an Access database:  

1. Go to the “External Data” tab and choose the Access icon from the Import & Link 

box.  

  

2. The “Get External Data – Access Database” will open up.  
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3. Browse for the source of the data.  

4. Choose “Link to the data source by creating a linked table.”  

5. Hit “OK.”   
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Linking to a SharePoint List  
To link to a SharePoint list:  

1. Go to the “External Data” tab and choose the “More” icon from the Import & Link 

box.  

2. Select “SharePoint List” from the dropdown menu.  

 

3. The “Get External Data – SharePoint Site” will open up.  
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1. Specify a SharePoint site.  

2. Choose “Link to the data source by creating a linked table.”  

3. Hit “OK,” or “Next” if applicable.  

  

  

Linking to a Text or XML File  

To link to a text file:  

1. Go to the “External Data” tab and choose the Text File icon from the Import & 

Link box.  



   

Best STL 2014 ©  www.microsofttraining.net  Page 63  

  0845 5194 797  

  

2. The “Get External Data – Text File” will open up.  

  

3. Browse for the source of the data.  

4. Choose “Link to the data source by creating a linked table.”  

5. Hit “OK.”  

  

To link to an XML file:  
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1. Go to the “External Data” tab and choose the XML File icon from the Import & 

Link box.  

 

2. The “Get External Data – XML File” will open up.  

  

3. Browse for the source of the data.  

4. Hit “OK.”  

Other Types of Links  

To link to an ODBC database:  
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1. Go to the “External Data” tab and choose the ODBC Database icon from the 

Import & Link box.  

 

2. The “Get External Data – ODBC Database” box will open up.  

  

 

3. Choose “Link to the data source by creating a linked table.”  

4. Hit “OK.”  

To link to a data service:  
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1. Go to the “External Data” tab and choose the “More” icon from the Import & Link 

box.   

2. Select “Data Services” from the dropdown menu.  

  

 

3. The “Create Link to Data Services” box will open up.  
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4. Choose the “Install new connection” button on the bottom left hand side, and 

follow the prompts to set up a connection.   

5. Select a connection from the left hand side of the box. Details for that connection 

will pop up on the right side of the box.  

6. Specify link name in the box near the bottom left hand corner of the box (right 

above the “Install new connection” button.  

7. Hit the “Create Linked Table” button in the bottom right hand side, right next to 

the “Close” button.  

  

To link to an HTML document:  

1. Go to the “External Data” tab and choose the “More” icon from the Import & Link 

box.  

2. Select “HTML Document” from the dropdown menu.  
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3. The “Get External Data – HTML Document” will open up.  
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1. Browse for the source of the data.  

2. Choose “Link to the data source by creating a linked table.”  

3. Hit “OK.”  

  

To link to an Outlook folder:  

1. Go to the “External Data” tab and choose the “More” icon from the Import & Link 

box.  

2. Select “Outlook Folder” from the dropdown menu.  

 

3. The “Get External Data – Outlook Folder” box will open up.  
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4. Choose “Link to the data source by creating a linked table.”  

5. Hit “OK.”  

To link to a dBASE file:  

1. Go to the “External Data” tab and choose the “More” icon from the Import & Link 

box.   

2. Select “dBASE File” from the dropdown menu.  
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3. The “Get External Data – dBASE File” box will open up.  

  
 

4. Choose “Link to the data source by creating a linked table.”  

5. Hit “OK.”  
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Module Nine: Importing Data  

In this module, students will learn how to import data. Topics will include importing from 

an Excel spreadsheet, importing from an Access database, importing from a SharePoint 

list and importing from a text or XML file. We will also look at other types of imports.   
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Importing From an Excel Spreadsheet  
To import from an Excel spreadsheet:  

1. Go to the “External Data” tab and choose the Excel icon from the Import & Link 

box.  

  

2. The “Get External Data – Excel Spreadsheet” box will pop-up.   

  
3. Browse for the source of the data.   

4. Choose “Import the source data into a new table in the current database.”  

5. Hit “OK.”   
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Importing from an Access Database  
To import from an Access database:  

1. Go to the “External Data” tab and choose the Access icon from the Import & Link 

box.  

  

2. The “Get External Data – Access Database” will open up.  
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6. Browse for the source of the data.  

7. Choose “Import tables, queries, forms, reports, macros, and modules into the 

current database.”  

8. Hit “OK.”   
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Importing from a SharePoint List  
To import from a SharePoint list:  

1. Go to the “External Data” tab and choose the “More” icon from the Import & Link 

box.  

2. Select “SharePoint List” from the dropdown menu.  

  

3. The “Get External Data – SharePoint Site” will open up.  
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4. Specify a SharePoint site.  

5. Choose “Import the source data into a new table in the current database.”  

6. Hit “OK,” or “Next” if applicable.  

  

  

Importing From a Text or XML File  

To import from a text file:  

1. Go to the “External Data” tab and choose the Text File icon from the Import & Link 

box.  
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2. The “Get External Data – Text File” will open up.  

  

3. Browse for the source of the data.  

4. Choose “Import the source data into a new table in the current database.”  

5. Hit “OK.”  
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To link to an XML file:  

1. Go to the “External Data” tab and choose the XML File icon from the Import & Link 

box.  

  

2. The “Get External Data – XML File” will open up.  

  

3. Browse for the source of the data.  

4. Hit “OK.”  

  

Other Types of Imports  

To import from an ODBC database:  
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1. Go to the “External Data” tab and choose the ODBC Database icon from the Import 

& Link box.  

  

2. The “Get External Data – ODBC Database” box will open up.  

  

5. Choose “Import the source data into a new table in the current database.”  

6. Hit “OK.”  
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To import from an HTML document:  

1. Go to the “External Data” tab and choose the “More” icon from the Import & Link 

box.  

2. Select “HTML Document” from the dropdown menu.  

  

3. The “Get External Data – HTML Document” will open up.  
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4. Browse for the source of the data.  

5. Choose “Import the source data into a new table in the current database.” 6. Hit 

“OK.”  

  

To import from an Outlook folder:  

1. Go to the “External Data” tab and choose the “More” icon from the Import & 

Link box.  

2. Select “Outlook Folder” from the dropdown menu.  
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3. The “Get External Data – Outlook Folder” box will open up.  
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4. Choose “Import the source data into a new table in the current database.” 5. 

Hit “OK.”  

  

Module Ten: Exporting Data  

In this module, students will learn how to export data. Topics will include saving an object as 

a PDF, exporting to an Excel spreadsheet, exporting to a SharePoint list and exporting to a 

Word or text file. We will also look at other types of exports.   
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Saving an Object as a PDF  
  

To save an object as a PDF:  

1. Go to the “External Data” tab and choose the PDF or XPS icon from the Export box.  

  

3. The “Publish as PDF or XPS” box will pop up.  
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9. Choose a “Save in” location.  

10. Specify a file name and ensure that the “Save as type” is PDF  

11. Place a checkmark in the “Open file after publishing” box if you want to select that 

option.  

12. Select an “Optimize for” choice.  

13. Hit “Publish.”   
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Exporting to an Excel Spreadsheet  
  

To export to an Excel spreadsheet:  

1. Go to the “External Data” tab and choose the Excel icon from the Export box.  

  

2. The “Export – Excel Spreadsheet” box will pop-up.   
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3. Browse for the destination file.   

4. Select a file format.  

5. Place a checkmark in the “Export data with formatting and layout” box.  

6. The option to “Open the destination file after the export operation is complete” will 

open up. Choosing this is optional. Place a checkmark in the box if you want it. 7. Hit 

“OK.”  

  

Exporting to a SharePoint List  
  

To export to a SharePoint list:  

1. Go to the “External Data” tab and choose the “More” icon from the Export box.  

2. Select “SharePoint List” from the dropdown menu.  

  

3. The “Export – SharePoint Site” will open up.  
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4. Specify a SharePoint site.  

5. Choose a name for the new list.  

6. Write in a description of the new list  

7. Place a checkmark in the “Open the list when finished” box if you want that option. 8. 

Hit “OK.”  

  

  

Exporting To a Word or Text File  

  

To export to a Word file:  

1. Go to the “External Data” tab and choose the “More” icon from the Export box.  
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2. Select “Word” from the dropdown menu.  

  

3. The “Export – RTF File” box will open up.  

  

  

4. Browse for the file that you want to export the data to.  
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5. Place a checkmark in the “Export data with formatting and layout” if it is not already 

selected.  

6. Place a checkmark in the “Open the destination file after the export operation is 

complete” if you want to choose that option.  

7. Hit “OK.”  

  

To export to a text file:  

1. Go to the “External Data” tab and choose the Text File icon from the Export box.  

  

2. The “Export – Text File” will open up.  
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3. Browse for the file that you want to export the data to.  

4. Place a checkmark in the “Export data with formatting and layout.”  

5. Place a checkmark in the “Open the destination file after the export operation is 

complete” if you want to choose that option.  

6. Hit “OK.”  

  

Other Types of Exports  

  

To export to an ODBC database:  

1. Go to the “External Data” tab and choose the “More” icon from the Export box.  

2. Select “ODBC Database” from the dropdown menu.  
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3. An Export box will pop up. Type in the name of the place in which you want to 

export the current database to.  

 

4. The “Select Data Source” box will open up. Choose the file source data from the 

dropdown menu and specify a DSN name. You can also use a machine data source.   

  

7. Hit “OK.”  
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To export to an HTML document:  

1. Go to the “External Data” tab and choose the “More” icon from the Export box.  

2. Select “HTML Document” from the dropdown menu.  

  

3. The “Export – HTML Document” will open up.  

  

4. Browse for the file that you want to export the data to.  
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5. Place a checkmark in the “Export data with formatting and layout.”  

6. Place a checkmark in the “Open the destination file after the export operation is 

complete” if you want to choose that option.  

7. Hit “OK.”  
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Module Eleven: Advanced Database Tools  

In this module, students will learn how to use advanced database tools. These tool include 

the database documenter, the analyze performance functions and the repair/compact 

database tool.    
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Using the Database Documenter  
  

1. Click in the “Database Documenter” under the Database Tools tab in the Analyze 

box.  

  

2. The documenter box will pop up. Put a check mark in the box next to each part of 

the database that you want to print.  

  

3. Hit “OK.”  
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1. View your selected items in print mode. You can view one, two or more pages at a 

time. You can also change the size and margins, insert columns or switch to 

landscape formatting before you print.  

  

2. You can also zoom in on your document by clicking directly on it.  

  

 

Analyzing Table Performance  
  

1. Click on the “Analyze Performance” button under the Database Tools tab in the 

Analyze box.  
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2. The Performance Analyzer box will open up. Choose the Tables tab and then 

place a check mark next to the tables that you want to analyze.  

  

3. If there are suggestions for improvement, you will be notified of them and able to 

make the suggested changes. 

  

If there are no suggestions a message displays. 
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Analyzing Database Performance  

  

1. Click on the “Analyze Performance” button under the Database Tools tab in the 

Analyze box.  

  

2. The Performance Analyzer box will open up. Choose the Current Database tab and 

then place a check mark next to the tables that you want to analyze.  

  

3. Hit “OK.”  

1. The Performance Analyzer box will open up with analysis results. There are 4 result 

categories:  

a. Recommendation  

b. Suggestion  
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c. Idea  

d. Fixed  

2. Click on the recommendations, suggestions and ideas that you want to implement.   

  

3. Hit the “Optimize” button.  

  

  

Compacting and Repairing a Database   

You can compact and repair a database in one of two ways:  

4. Click on the pink “File” button.  

5. Choose “Info” from the left-hand side menu.  

6. Select the “Compact & Repair” button.  
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Or:  

4. Close all of your open items.  

5. Click on the “Database Tools” tab.  

6. Select “Compact & Repair Database” from the Tools box.  
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Module Twelve: Wrapping Up  

Although this workshop is coming to a close, we hope that your journey to improve your 

Advanced Access skills is just beginning. Please take a moment to review and update your 

action plan. This will be a key tool to guide your progress in the days, weeks, months, and 

years to come. We wish you the best of luck on the rest of your travels!   

Words from the Wise  

Here are just some of the features that set Access apart from its predecessor versions:  

  

• "Conditional formatting now supports data bars and you can now manage your 

conditional formatting rules from a single intuitive view."  

  

• "The addition of Office themes in Access gives you the ability to coordinate 

numerous database objects."  

  

• "Build your databases with new modular components using new Application Parts 

and add prebuilt Access components for common tasks to your database."  

  

• "The Backstage view replaces the traditional File menu in all Office applications to 

provide a centralized, organized space to manage your database and customize your 

Access experience."  

  

• "Expression Builder simplifies your formulas and expressions with IntelliSense."   

 


